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Agenda

• Overview – What are we trying to 
accomplish? Leverage Technology

• Brief view of traditional telecom
• Voice-over IP (VoIP)
• The Open Source Business Model
• Introducing G.PAK™: An open source 

VoIP DSP software application
• Hands-on Examples



• It is difficult enough to keep up with the 
pace of complexity in technology, let alone 
make use of it.

• How do we make use of very complex 
technology?
– We stand on the shoulders of those who 

preceded us.

Leveraging Technology



Overview
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Semiconductors:
Managing Complexity

• IC Design
– 1960s and 1970s: transistors
– 1970s and 1980s: gates
– 1990s-Present: VHDL, functional blocks, 

cores, etc.
• Can you imagine designing a DSP or 

Pentium chip from transistors?



DSP Application Complexity
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DSP Application: 
Managing Complexity

• DSP Software
1970s: Hardware Implementations and Microcode
1980s: Assembly Language Coding
1990s: High-Level Language (“C”) Coding, Libraries, 
Operating Systems
2000s: Application-Specific Signal Processors 
(ASSP)

• Can you imagine writing a complete VoIP DSP 
application in Microcode or assembly language 
code?



DSP Applications: 
Today’s Options

• Start From Scratch
• Leverage DSP Libraries
• Leverage Operating System
• Leverage Software Framework
• Leverage ASSPs
• Leverage Open Source Software



Leveraging Proven Algorithms

• Voice Quality – the bottom line
• Field hardened algorithms
• Voice Quality related algorithms:

Echo Cancellation
Conferencing
Automatic Gain Control (AGC)
Packet Loss Concealment (PLC)
Discontinuous Transmission (DTX)



DSP Applications:
Today’s Options
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Introducing Open-Source DSP

• Open-Source DSP lies between the ASSP 
and custom development.

• With open-source, you can
Leverage existing software
Focus on your application
Keep control of your design
Hit the market quickly with your product



Cost and Flexibility
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Brief View of Traditional 
Telecom
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A Few Voice Compression Standards
Product MOS Rate(s) MIPS 

G.711 4.1 64 0.36 

G.726 (Low Mem) 3.9 (32 kbps) 16, 24, 32, 40 11.0 

G.726 (Low MIPS) 3.9 (32 kbps) 16, 24, 32, 40 9.8 

G.729 3.9 8 21.5 

G.729B 3.9 8 22.2 

G.729A 3.7 8 11.4 

G.729AB 3.7 8 12.2 

G.728 3.7 16 35.0 

G.723.1 3.9/3.6 6.3/5.3 16.9/16.5 

G.722 48, 56, 64 15.6 



PSTN Functions

• PSTN Functions

Call Setup/Teardown
Pass Signaling (next slide)

Pass Voice, Fax, Modem Signals



Signaling
• Dual-Tone Multi-Frequency (DTMF) 

Dialing (or Touch-Tone Dialing) 
• Pulse Dialing
• Hook-Switch Signaling
• Ringing
• Hook Flash
• Disconnect
• Many others



Transition to VoIP

• Signaling – must be captured and sent in 
packets. Why? 

• Tonal Signaling – may need to be 
captured and sent in packets. (Next Slide)

• Modem Signals – may need to be relayed 
(T.38 Fax Relay)

• Voice – G.711 PCM  or further 
compression



Need for Tone Relay

FFT Before Speech Compression FFT After G.729A Compression (8 kbps)



Tone or Fax Relay
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VoIP



VoIP

ATA / Gateway
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Voice Over Data Networks

• Why carry voice over data networks?

• PSTN vs. Data Networks

• Integrating voice into data networks



Traditional Voice And Data Networks
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Traditional Voice and Data Networks

• Circuit Switching - A circuit is dedicated 
to a specific communication link for the 
duration of the call.

• Packet Switching - Packets of data sent 
from user A to user B are not 
necessarily carried on the same 
physical circuit; allows for sharing of 
circuits.
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Why Carry Voice on Data Networks?

Advantages

Share Hardware 
Costs
Share Access Costs
Reduce Long 
Distance Charges

Disadvantages

Network Impairments
Security?



Issues With VoIP

• Types of errors
Bad packet 
received
Missing packet
Packet received 
out of order

• Recover Mechanisms
ACK/NACK
Sequence Numbers
Packet Retransmission
Timers
Drop packet on floor



Error Recovery – Why Not?

• By the time an error is detected and 
recovered, it’s too late to play out the voice.

• RTP (Real-time Transport Protocol) does not
implement error recovery.

• RTP does handle re-sequencing out-of-order 
packets and detecting lost or late packets

• RTP may be used with diversity



Packet Transmission Errors
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Integrating Voice into Data Networks

• Traditionally, voice has been transmitted over 
circuit switched networks with constant data 
rate and delay.

• Data networks introduce many undesirable 
characteristics that need to be addressed:

Blocking
End-to-end delay
Delay jitter

Packet Loss
Header overhead
Throughput



Integrating Voice into Data Networks
• Desired Features for Packet Voice Implementation

Compression
Silence compression (a.k.a. DTX)
Jitter Compensation
Packet Re-sequencing
Packet Loss Concealment
Transmission of Signaling
Echo Control



VoIP Summary
• Data networks are not inherently suited 

to voice transmission. Data networks 
are packetized and bursty in nature. 
Voice signals are more continuous in 
nature.

• Special care must be taken when 
integrating algorithms to minimize the 
effects of the network.



The Open Source Business Model
• Open Source does not necessarily mean free software
• GPL (GNU General Public License)

The most widely known open-source license.

• Other Open-Source Licenses

Academic
Apache
Apple®
BSD
CPL
Eclipse™
Intel®
Lucent

Microsoft®
MIT
Mozilla®
NASA
Nokia®
Python®
RealNetworks
Sun™
Many More



GPL - The Up-Side for a Vendor
• Market Penetration
• Become the de facto standard
• High Visibility
• Sell additional services
• Sell associated hardware
• License associated software
• Many customers will pay to license software to 

obtain support and to avoid GPL restrictions



GL - The Down-Side for a Vendor

• Enables competitors

• Exposes intellectual property / trade secrets

• Code Contamination



• No need to reinvent the wheel
• Leverage existing code that hopefully already 

works
• Faster time to market

GPL - The Up-Side for a Vendor



GPL – The Down-Side for a Developer

• You must open up your source
• Enables competitors
• Exposes intellectual property / trade secrets



GPL - The Up-Side for Users

• Free software is available



GPL - The Down-Side for Users

• Free software comes with no warranty 
and no support. Proceed at your own risk.

• Free software tends to be light on 
documentation.



G.PAK Source Licensing
• G.PAK license is not under GPL. 

Why Not?
G.PAK framework source code is not 
redistributable (protects our IP)
Derivative works are therefore not 
required to be redistributed
(protects your IP)

• Unpaid license comes without support



G.PAK Source License

• You Must:

Use G.PAK 
source code in 
conjunction with 
Adaptive Digital’s 
algorithm libraries

• You May Not:

Redistribute 
G.PAK Source 
Code



G.PAK: An Open Source 
VoIP DSP Framework

• G.PAK Overview
• G.PAK Channel Types
• Interfacing with G.PAK via host
• Host supplied routines
• G.PAK Internals
• Modifying G.PAK with new Vocoders



G.PAK Features
• Most Standard Vocoders 
• Multiple Channel Types (PCM-PKT, PCM-PCM…)

• Conferencing
• Echo Cancellation (PCM and Packet)

• Voice Activity Detection/Comfort Noise
• Tone Detection and Generation 

(DTMF, MFR1, MFR2 FORWARD, MF2 BACK, CALL PROGRESS)

• RTP/AAL2 Payload Formats
• Self Contained DSP Code
• Host API routines



G.PAK - Overview

• Algorithms vs. Turnkey
Algorithms – write your own framework
Turnkey – No DSP Programming

Turnkey – Shorter Time To Market
Lower NRE

Turnkey + Open Source – Increases 
flexibility and design/product control
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G.PAK Channel Types



PCM to PCM (TDM to TDM) Channel
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G.PAK: PCM to PCM Channel
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Example: PCM Echo Cancellation
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PCM – Packet Channel: VoIP Gateway



G.PAK: PCM to Packet Channel
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G.PAK: Packet to Packet Channel
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G.PAK: PCM to Conference Channel

Input
Serial

Port/Slot

PCM
Frame
Buffer

Conference
n

8 kHz

PCM In

PCM
Frame
Buffer

8 kHz

PCM Out

Output
Serial

Port/Slot

PCM In n

PCM Out n

Echo
Cancel AGC

Bulk
Delay

PCM of Other
Conference
Channels



GPAK: Packet to Conference
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G.PAK Data Flow

DMA Transfer
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Host Interface

• Configuration Messages

• Payload Transfer

• DSP Download

• CPU Usage



Host Interface: Layers

Host API            
HPI Driver           

HOST

DSP SWI_MSG           

Framing Tasks       

Channel Mux/Demux

DMA HWI

Serial Port(s)



Configuration Messages

gpakTearDownChannelTear Down Channel

gpakGetSystemConfigRead System Configuration

gpakReadSystemParmsRead System Parameters

gpakGetChannelStatusRead Channel Status

gpakConfigureChannelConfigure Channel

gpakConfigureConferenceConfigure Conference

gpakConfigurePortsConfigure Serial Ports

gpakWriteSystemParmsConfigure System Parameters

G.PAK API RoutineFunctionality



Payload Transfers

gpakGetPayloadFromDspRead payload from DSP

gpakSendPayloadToDspWrite payload to DSP

G.PAK API RoutineFunctionality



Other API Calls

gpakReadCpuUsageRead frame task statistics

gpakDownloadDspWrite image to DSP

G.PAK API RoutineFunctionality



Host Supplied Routines

gpakUnlockAccessReleases exclusive access to DSP’s memory

gpakReadFileReads data from ‘File’ for DSP download

gpakLockAccessProvides host task with exclusive access to 
DSP’s memory

gpakHostDelayDelays at fixed time interval before polling for
message responses

gpakWriteDspMemoryWrites memory at specified DSP address

gpakReadDspMemoryReads memory from specified DSP address

FunctionalityRoutine



Hands-On Exercises

1. Use DSP Resource Wizard to estimate 
resource requirements and select DSP

2. Use G.PAK Configuration Builder to build 
DSP image (Load and test)

3. Customize G.PAK Source Code (Load 
and Test)



Hands On #1: DSP Resource Wizard
1. Use DSP Resource Wizard to size   

application and select DSP

2. Browse to c:\adaptivedigital\tidc

Available at 
http://wizard.adaptivedigital.com

3. Double-click on DSPResourceWiz.htm

4. Select DSP, algorithms, and channel count



Hands On #2: G.PAK Build

1. Use the G.PAK Configuration Builder 
to configure and build a DSP image

2. Load the DSP image into the DSK 
board

3. Use the host interface program to set 
up a phone call



G.PAK Configuration Builder
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Hands On #2: Step by Step
1. Start Code Composer Studio
2. Open the G.PAK Project 

Project -> Open ->
c:\adaptivedigital\tidc\gpakc64x\gpak64xdsp\gpak6416develop.pjt
(ignore the missing library warning – we’ll build that later)

3. Build the G.PAK Project
Project->Build
When prompted for a G.PAK Project, click 
on gpak6416develop.pjt



Hands On #2: Step by Step



Hands on #2: Step by Step

1. Select the G.729AB Vocoder

2. Click Build

3. The program will load when the build is 
complete

4. Start the program – Debug -> Run



Hands On #2: Step by Step

1. Start the host interface tool
Double-click on 
c:\adaptivedigital\tidc\Gpak64x\gpakhostinterface.exe

2. Click on RTDX

3. The host interface tool will appear



Hands On #2: Step by Step



Hands On #2: Step by Step
1. Set up the serial port (Click Port Params) 

This screen will come up:

2. Use Defaults

3. Click OK



Hands On #2: Step by Step

1. Set up a TDM to Packet channel. 
The following screen will come up:

2. Use Defaults

3. Click OK



Hands On #2: Step by Step

1. Start your audio source

2. Listen to the output

3. Other things to try: 
change the vocoder from G.729AB to G.711 
using the channel setup command



Hands On #2: Review
• Use DSP Resource Wizard to check DSP 

resource requirements

• Configure and build the DSP image

• Load and run the DSP image

• Use the host interface program to 
configure the DSP software and set up a 
PCM-Packet channel
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Hands-On #3: Adding an Algorithm
• We will modify the G.PAK source code to 

add a reverb algorithm to the voice path

• View reverb.h

Delay
Line

Buffer

+PCM In PCM Out

Attenuation
(scaling)



Hands-On #3: Adding Reverb
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Adding a New Algorithm

Important note about auto-generated files
The G.PAK configuration utility modifies some 
source files.

If you are modifying source files, these source 
files will be overwritten if you re-run the 
G.PAK configuration utility.



Adding New Algorithms

• Memory Allocation
• Instantiation
• Initialization
• Signal Processing
• Teardown



Memory Allocation / Instantiation

Add references to Reverb instance and pooling 
information

GpakExts.h

Instantiate Reverb channels and pooling dataGPak6416Devel
op.c

Include file reverb.hGpakDefs.h

AdditionFile



Initialization

New Function – Pulls a Reverb channel 
from pool and initializes it

GpakFrame.c / 
initReverbChannel

Mark all Reverb channels in pool as 
available

GpakMsg.c / 
InitGpakInterface

Call initReverbChannelPcm2Pkt.c / SetupPcm2Pkt

Free Reverb channel to available poolGpakMsg.c / 
ProcConfigureChannelMsg

AdditionFile / Function



Signal Processing

Add call to the Reverb functionPcm2Pkt.c / 
FrameInPcm2Pkt

AdditionFile / Function



Teardown

New function to free a 
Reverb channel to the pool

GpakFrame.c / 
DeallocChanReverb

Call DeallocChanReverbGpakMsg.c / 
ProcTearDownChannelMsg

AdditionFile / Function



• Disable G.PAK Configuration builder so 
that it does not overwrite source files

From CCS:
1. Right Click on GPAKC6416Develop project in 

project pane
2. Click on Build Options
3. Click on “General” Tab
4. Place REM in front of the command that runs the 

configuration .EXE file
5. Click OK

Hands On # 3: Step by Step



• Replace gpak6416develop.c with 
gpak6416develop_handson_3.c

File -> Open gpak6416develop_handson_3.c
File -> Save As gpak6416develop.c

• Yes to overwrite warning

• Why did I do this?
The G.PAK configuration program rewrites 
gpak6416develop.c. We need a modified version for 
this exercise, which has been already created as 
gpakdevelop_handson_3.c.

Hands On # 3: Step by Step



• Open each of the following files:
GPAKDEFS.H
GPAK6416DEVELOP.C
PCM2PKT.C
PKT2PCM.C
GPAKFRAME.C

• In Each file, look for the occurrence of the 
word HANDS_ON to understand the code 
that the #ifdefs are enabling

Hands On # 3: Step by Step



• Change the project options in each CCS 
project to include the pre-processor 
definition HANDS_ON

Right click on a project
Click on Build Options
Click on the Preprocessor category
In the “Pre-defined symbols” line, append with 
“;HANDS_ON”
Repeat for all projects

Hands On # 3: Step by Step



• Rebuild the main project 
(GPAK6416Develop.pjt)

From the Project menu, click on Build

• Once the project builds successfully, the 
executable file will be loaded into the 
DSP on the DSK board.

Hands On # 3: Step by Step



1. Start the program
From the Debug menu click on Run

2. Switch windows tasks back to the Host 
Interface program.

Hands On # 3: Step by Step



Hands On #3: Step by Step



• Since the host program was already 
running, click on “Reconnect”. 
Click OK on the error messages

(We reloaded the DSP, causing the host 
program to become out-of-sync.)

Hands On # 3: Step by Step



1. Set up the serial port (Click Port Params) 
This screen will come up:

2. Use Defaults

3. Click OK

Hands On # 3: Step by Step



1. Set up a TDM to Packet channel. The 
following screen will come up:

2. Use Defaults

3. Click OK

Hands On # 3: Step by Step



1. Start your audio source
2. Listen to the output
3. Other things to try:

change the vocoder from G.729AB to G.711 
using the channel setup command

Hands On # 3: Step by Step



• Use DSP Resource Wizard to check DSP 
resource requirements

• Configure and build the DSP program
• Modify the source code to add reverb algorithm
• Rebuild the DSP software program
• Load and run the DSP program
• Use the host interface program to configure the 

DSP software and set-up a PCM-Packet channel
• Listen to the result

Hands On Review



• Importance of leveraging existing 
technology

• Use of open-source to leverage existing 
technology

• Open Source Licensing

Summary
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